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DB Search is an Mgears plugin that will allow you connect to one or more Mnova databases and search input
datasets to identify structures that have already been analyzed and saved to them, or to otherwise find
potentially similar structures (with similar 1H, 13C, or HSQC spectra) that can be used as references.

Follow the steps detailed below to run your very first analysis.

Remember: In order to run a DB Search analysis, you must have an active Mnova DB license and a
connection to the DB server, in addition to the Mnova Gears and DB Search licenses.

1. The workflow

Launch Mgears from the Mnova Automation ribbon. A dialog with six tabs will open.

MestReNova

Elucidation Chemometrics Binding Automation

@& @

Mgears Mgears MyGears MyGears
Vlewer Workflows

o®.k.

'El Input Processing Plugins Design B Output ﬁ Settings

A DB Search analysis will require you to set up the Input data, the Plugin settings, and the Output options.

1.1. The Input tab

The input spectra to be searched can be retrieved from Disk directories, a DB, or from Real-Time acquisition.
The configuration of the input for each of these cases is detailed in the Mnova Gears user manual.

In this example, we are going to analyze data saved in a Disk directory.
Click on - and select the data folder from your disk.

Oﬁ‘-

'Zl Input Processing Plugins Design E Output 'n- Settings

. =
'g‘ ‘Q Using Automatic Detection 3= Experiments Selection

Main Directory: C:/Users/Usuario/Desktop/Datasets/By Plugin/DB search/Input
Optional Directory:

i)

DB
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Optional. In some cases, you may need an additional layer of configuration to correctly retrieve the data
you want to analyze and exclude any other data files saved in the same location. To do so, you can (A) enable
the Experiment Selection option and manually select the experiment type and data you want to analyze; you
can also configure (B) the Advanced and (C) Filtering options according to your input options — as detailed in
the Mgears manual — which gives you huge flexibility and allows you to adapt Mgears to your instrument data
organization and formats.

9% Mnova Gears ? X

'El Input @ Processing Plugins Design B Output 'a Settings

C:/Users/Usuario/Desktop/Datasets/By Plugin/DB search/Input

Optional Directory:

NMR
IMItH  [spearum[B[ J13c D -|[J1F D  -|[Iwsqc|mp - |[Iwmc[mD  -|(J[  Jm -
5 L ]
NOESY  [orrmn TOCSY [FID ROESY [FID H2BC [FID cosy [FID FID @
Change All ||FID ¥

GC/LC/MS [ | Chromatography || UV/IR/Raman/Fluorescence | | Mnova Documents | | Orders | | Custom Format

@
E
IS
3
o
Advanced Options

v
Master File: ‘ ‘ .|
Main SDF File: | Tag with ID: ‘ :)
Allow More than One Experiment of Each Type v| Join Folders with Similar Name B
Experiment Selection Mode: | FID/Spectrum Filter by Date From: | 1 Jan 1970 ~ [To:[1 Jan 1970 ~ Filter by:|Creation Date -
Preview Subset Only 1000 = Regular Expression to Adapt Match /‘ ‘/ ;u
Y Filtering String:| ‘ Regular Expression Filter by Name Only
Filter. Mapping File: [ ‘ ... | [v] Substring Matching | {3¥

Enable the Automatic Detection feature (unless you opt for a manual Experiment Selection), then use the

Automatic inspection button @ to verify that Mgears has detected the data according to your configuration.

The experiments found will be listed as shown in the image below:

om 52
'El Input Processing Plugins Design B Output 'a' Settings

g |:Q Using Automatic Detection gé Experiments Selection @‘
Main Directory: C:/Users/Usuario/Desktop/Datasets/By Plugin/DB search/Input / |
Optional Directory: / 1 :
fa]
Q
i) d

List of detected experiments:
Experiment: SAMPLE 1
mnova: C:/Users/Usuario/Desktop/Datasets/By Plugin/DB search/Input/Sample 1.mnova

Experiment: SAMPLE 2
mnova: C:/Users/Usuario/Desktop/Datasets/By Plugin/DB search/Input/Sample 2.mnova

Experiment: SAMPLE 3
mnova: C:/Users/Usuario/Desktop/Datasets/By Plugin/DB search/Input/Sample 3.mnova

Experiment: SAMPLE 4
mnova: C:/Users/Usuario/Desktop/Datasets/By Plugin/DB search/Input/Sample 4.mnova

Experiment: SAMPLE 5
mnova: C:/Users/Usuario/Desktop/Datasets/By Plugin/DB search/Input/Sample 5.mnova

OK

If the experiment detection result is satisfactory you can move to the next step.
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1.2. The Plugins tab

In the Plugins tab, select and add the DB Search plugin.

= | Input EI Processing Plugins Design E Output 'a'Seltings
5 saa BN l
- Add
N@ Verify
ﬁ% Concentration Rem<0ve
.:% Purity +
oi’ﬁ DB Search | New
= Custom Plugin
N@# SMA

gﬁ QC Profiling

&# Multiplet Report
IUPAC Name

52 MS Scan

-
Delete
Custom Plugin
=5
L (2]

DB Search
Plugin Settings

Then, click on DB Search Plugin Settings to configure your analysis preferences.

B Output a Settings
S

Add

|

Remove

I

New
Custom Plugin
-

Delete
Custom Plugin

=2
N
DB Search
Plugin Settings

i&—' DB Search

The DB Search Settings dialog will appear, which has four tabs.
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1.2.1. The DB Selection tab

In the DB selection tab, you must select the databases to be searched.

Click on + to add a database. In the Connection dialog that appears, enter the server connection details and

credentials, then press Connect.

Once the connection is established, select the Database you wish to use in your search, then press OK. The

selected database will appear in the Selected Databases table, as shown in the example below.

Click on + a second time to add another database if needed, oron = to delete a previously added database.

% %
i (= w =
Load Settings  Save Settings Load Settings ~ Save Settings
DB Selection Search Method Report Options DB Selection Search Method Report Options
Selected Databases Selected Databases
Name Server % Name Server
-
Acids localhost @
% 0@ Connection ? X o@
Server:  |localhost Port: |5504 Server: [localhost |Port: Server: [localhost |Port:
User: Test PaSSWOI'd:|-------¢ User: Test Password: [esesssse User: Password: |ssssssss
Database: | D8 2022 b | Connect e Canc | Database: Acdids = Disconnect Database: Adds ~ | Disconnect
Adids Fil
oK Cancel Hetaolites Cancel 5 Cancel

1.2.2. The Search method tab

OK Cancel

In the Search Method tab, choose the method you want to apply to search the database(s). DB Search can use
Peaks, Multiplets, or peak Similarity to search 1H or 13C NMR spectra, and Peaks and Similarity search for

HSQC spectra.
%
] [
Load Settings ~ Save Settings %
DB Selection Search Method Report
P r‘.— |._|
1H 13C  HSQC Load Settings ~ Save Settings
i Search Method
® Peaks Search |Purity - DB Selection carch Fetho s
Multiplets Search 1H 13C HSQC

Sl BN e . Peaks Search |Purity v

Multiplets Search
Similarity Search

P/N 238 R1.1

%

I

Save Settings

o
Load Settings
DB Selection Search Method

Report Options

iH 13C HSQC

® . Peaks Search  Purity ~
Similarity Search

OK

Cancel
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Within the Peak search option, you can choose one of the three proposed search modes, Compound, Mixture,
or Purity, depending on your experiment. Each mode will apply a different scoring algorithm to find the best
matches to your query in the searched database(s):

— The Compound mode is useful when your query data includes pure compounds, and the searched
database(s) contains mixtures and/or compounds with impurities.

— The Mixture mode is useful when searching for the components of a mixture within a database of
pure compounds.

— The Purity mode allows you to search directly for the best match to the query spectrum in the
database(s).

For this example, we will use Peak search in the Mixture mode.

% DB Search Settings ? X

w H

Load Settings  Save Settings

DB Selection Search Method Report Options
1H 13C HSQC

@ Peaks Search |Mixture [Tl

Multiplets &ar%
Similarity SearcFur

1.2.3. The Report tab

In the Report tab, you must decide the maximum number of hits you want to show in each results report.

You can also decide whether to include a Stack with the analyzed spectrum and the hits found or whether to
Draw a Hits Table.

NG 55 N

% - Hit 2 ﬁu L
i — ] 1 L
= :
- H Hit 1 | b
Load Settings  Save Settings T
P i Ll 1
DB Selection  Search Method — A
Query ENE|E | :
Options . [ i ) |

Hits per Report: |7

v| Stack Result
v| Draw Hits Table

| # | stucture | Structure Label | TYPE | Solvent | _Database | Saore |

Hit1 - Record ID 1 Compound-44289 | 1H d20_10 lo@lhost - Adds 1000
Hit 2 - Record ID 4 Compound-24315  |1H d20_10 localhost - Adds |1000
Hit 3 - Record ID 3 Compound-05271  |1H d20_10  loclhost - Adds (733
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If you wish to apply a Custom Layout Template to your result reports, you can upload it here. Otherwise, the
default layout will be applied.

Layout

No Layout

® Custom Layout Template

{C:/Users/Usuario/Desk‘top/Iayout.mnova

Apply Single Page Template to Each Page

9] layout X O] SAMPLE 1* X
# | Structure | Structure Label | TYPE | Solvent | Database | Score
N Hit 1 - Record ID 1 Compound-44289 [IH  |d20_10 |locaihost - Adds 1000 ”
Hit2 - Recrd 1D 4 Compound-24315 |1H  [d20_10 locaihost - AGds |1000
Mestrelab Research Mestrelab Research

Hit3 - Reard 1D 3 Compound-05271 |1H  |d20_10 loaihost - Acds 733

Text: TextBox, [HitsTitle]

Parameter Vae

Data Fle Name X/ 2014/
20140630/
Asprn_phs C_ T
est_01/
Aspim_phs C T
est_NOESY_02.fi
d/ fid

Experment 10

Number of Scans 128

able, [Parameters,stacked ReceverGan 0

Relixaton Dely 3.5000
I “ 1 4 l [+ Pusewdth  0.0000
AL i W0 Acquston Tme 23000

Spectrometer  599.93
1 Frequency
Spectral With  9615.4
- + Lowest 1154
Frequency
Lo Nudeus "
] L Acqured Sze 24038

N EL

Layout T s e s Result

NMR Spectrum: 1D, [stacked, 1H - MAIN] = |‘

If you enable the Apply Single page template to each page, the layout will be applied recursively on every
page of your report.

1.2.4. The Options tab

Finally, in the Options tab, you can check the Do not Write Results Document if the Search Returns 0 Hits.
This way, Mgears will not produce Mnova nor PDF documents if the search does not return any hits.

You can choose to include Spreadsheet Functions in the CSV results file to easily access the corresponding
Mnova and PDF files.

You can also decide whether to Write Mnova Document with your search results.

%

w -
Load Settings  Save Settings
DB Selection Search Method Report Options
Do not Write Results Document if the Search Returns 0 Hits
v | CSV with Spreadsheet Functions

v | Write Mnova Document

I

Top tip! Note that you can save the settings of your current analysis for future use by clicking on |Save Settings |
DB Search settings will be saved as a “.data” file. When you start a new analysis, you will then be able to

—
w
directly load these settings by clicking on | Load Settinos | gnd opening the saved settings file.
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Once you are done choosing you DB Search settings, you must click on OK to save them, then proceed to the
Mgears output tab.

1.3. The Output tab

Here, you must choose a directory in which to save your analysis results. Click on - and select a results folder
on your disk.

Q

@M ]
'El Input Processing Plugins Design E’ Output
Disk

Directory: |C:/UserSIUsuario,'Desktop/ResultleB Search I | Add Nickname

Optionally, enable the Add Nickname to the Results Folder and type the nickname of your choice, Add
Incremental Numbering to your results folder, and/or decide to use Only the Nickname in the folder’s name.

O® )
'El Input EI Processing Plugins Design E Output Q Settings
Disk

Directory: IC:/UsersfUsuario,’Desktop/Results/DB Search 1 | v| Add Nickname to the Results FolderI IStam‘ngGuide v| Add Incremental Numbering

You can also choose to create an Mnova document, a PDF, or to save your results to a DB.

Note. If you wish to view/review the spectra along with the results in the Mgears Result Viewer, you must

enable Mnova document creation. Otherwise, when loading the results in the Mgears Result Viewer, only the
data will be visible, with no spectra.

Once the configuration has been completed to your satisfaction, click on Run ° RUN to launch the analysis.
Each query file will be opened and run against all the selected DBs.

Log:

Sample 1.mnova opened successfully a
[2022-11-21T15.46.17] Analysing dataset SAMPLE 1

[2022-11-21T15.46.17] Saving Resume file...

[2022-11-21T15.46.18] Starting DBSearch Automation Engine

[2022-11-21T15.46.41] Saving Resume file...

[2022-11-21T15.46.41] Dataset SAMPLE 1 processed

[2022-11-21T15.46.42] File C:/Users/Usuario/Desktop/Datasets/By Plugin/DB search/Input/
Sample 2.mnova opened successfully

[2022-11-21T15.46.42] Analysing dataset SAMPLE 2

[2022-11-21T15.46.42] Saving Resume file...

[2022-11-21T15.46.42] Starting DBSearch Automation Engine

> 1 n

Estimated Time Left: 0 hours 1 minutes 39 seconds
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2. The output folder

The results folder is saved under the previously specified directory, as described above.

Results > DB Search > 2022-11-21T15.46.08_StartingGuide-1

Name

css

data

~

DBSearch

documents

images

js

pdf

| 2022-11-21T15.46.08

] 2022-11-21T15.46.08.resume

G SearchDB-Results

:'I settings.mgrs

This folder contains all the output generated in the current evaluation, which includes:

2.1. An HTML file

The HTML report gives an overview of the results. Each query spectrum will be displayed on a line with the

Number of Hits, the Best score, and links to the appropriate PDF and Mnova result files.

Mgears DB Search Results

Parameters
Parameter Value
Results Directory C:/Users/Usuario/Desktop/Results/DB Search/2022-11-21T15.46.08_StartingGuide-1
Method 1H using Peaks Search with method Mixture / HSQC using Peaks Search with method Mixture
Started On 2022-11-21T15:46:08
Completed On 2022-11-21T15:48:35

Detailed Results

Show s v entries

A
# 1H Hits 1H Best Score

1H Pdf

Copy CSV  Column visibility Print

1H Mnova

HSQC Hits HSQC Best Score

Search:

HSQC Pdf

HSQC Mnova

3 1000
2 1 608
3 1 1000
4 6 1000
2 0

1H-SAMPLE 1.pdf

1H-SAMPLE 2.pdf

1H-SAMPLE 3.pdf

1H-SAMPLE 4 .pdf

1H-SAMPLE 5.pdf

1H-SAMPLE 1.mnova

1H-SAMPLE 2.mnova

1H-SAMPLE 3.mnova

1H-SAMPLE 4.mnova

1H-SAMPLE 5.mnova

1000

HSQC-SAMPLE 3.pdf

HSQC-SAMPLE 3.mnova

Showing 1 to 5 of 5 entries

P/N 238 R1.1
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"

The HTML format allows you to change the display of the columns and adapt them to your preferences. You

can then Copy, Print, or download a CSV file with the results.

Copy

Csv Print

Column visibility

#
1H Hits

:1.pdf

. 2.pdf

. 3.pdf

2.2. ACSVfile

1H Best Score

1H Pdf

1H Mnova

HSQC Hits
HSQC Best Score

1H-SAMPI

HSQC Pdf
HSQC Mnova

411 SARary e DT

The CSV file saved under the “DBSearch” subfolder, contains input and output information data, including the

Dataset and Spectrum names, the Hit number, the Record ID, the Type of hit spectrum, the Solvent, the
Server, the Database, the Score, and the path to the Mnova and PDF result files.

If the option to include hyperlinks in the Mnova and PDF result files is enabled in the plugin settings, those

hyperlinks are included in the CSV instead of the location path.

A B C

1 Dataset Spectrum Title Structure

2 SAMPLE 1 #=g'si %7 w=y NOESY_01 Compound-44289
3 |SAMPLE 1 fwmem wem_NOESY 01 Compound-24315
4 SAMPLE1 B .& «_NOESY_01 Compound-05271
5 |SAMPLE 2 spm= g 2st_ NOESY_0 Compound-33456
6 |SAMPLE 3 }Eid (T ‘W_1DP_noe HMDB0O0142#0
7 |SAMPLE 3 =% =9 01_HW_2DHS HMDBO00142#0
8 |SAMPLE 4 g = _NOESY_01 Compound-44289
9 SAMPLE4 & & ' [ «_NOESY_01 Compound-24315
10 SAMPLE 4 =g “  ®= _NOESY_01 Compound-33456
11 SAMPLE 4 fwmom wem_NOESY_01 Compound-05271
12 SAMPLE4 I & «_NOESY_01 Compound-87200

__m=_NOESY_01

Compound-26549

13 SAMPLE 4 smpmems ¢

2.3. An Mnova and PDF file

D E F G H |
Hit Record Type Solvent Server

1 1 1H d2o_10 localhost  Acids
2 4 1H d2o 10 localhost  Acids
3 3 1H d2o_10 localhost  Acids
1 8 1H d2o_10 localhost  Acids
1 6 1H D20 localhost  Acids
1 6  HSQC H20+D20_met localhost  Acids
1 1 1H d2o_10 localhost  Acids
2 4 1H d2o_10 localhost  Acids
3 8 1H d2o_10 localhost  Acids
4 3 1H d2o_10 localhost  Acids
5 2 1H d2o_10 localhost  Acids
6 5 1H DMSO localhost  Acids

J

Database Score

1000
1000
733
608
1000
1000
1000
1000
956
933
913
733

K
Mnova
1H-SAMPLE 1.mnova
1H-SAMPLE 1.mnova
1H-SAMPLE 1.mnova
1H-SAMPLE 2.mnova
1H-SAMPLE 3.mnova

L
PDF
1H-SAMPLE 1.pdf
1H-SAMPLE 1.pdf
1H-SAMPLE 1.pdf
1H-SAMPLE 2.pdf
1H-SAMPLE 3.pdf

HSQC-SAMPLE 3.mnova HSQC-SAMPLE 3.pdf

1H-SAMPLE 4.mnova
1H-SAMPLE 4.mnova
1H-SAMPLE 4.mnova
1H-SAMPLE 4.mnova
1H-SAMPLE 4.mnova
1H-SAMPLE 4. mnova

1H-SAMPLE 4.pdf
1H-SAMPLE 4.pdf
1H-SAMPLE 4.pdf
1H-SAMPLE 4.pdf
1H-SAMPLE 4.pdf
1H-SAMPLE 4.pdf

o

Path to location
or hyperlink

The PDF and Mnova documents, saved under the “DBSearch” subfolder, have similar structures and follow
the applied layout template (default or custom one).

The default layout shows:

— The Hits table on the first page (if the appropriate option is enabled).

— The Query spectrum on the second page.

P/N 238 R1.1
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”

— Each Hit spectrum displayed with the Query spectrum on a separate page or - if stack option is enabled

- the Query and Hit spectra are stacked on the same page.

[@) SAMPLE 1 x

Structure Label Solvent
Hit1 - Record ID 1 Compound-44289 1H d20_10
/II\ .
Hit 2 - Record ID 4 | i Compound-24315 1H d2o0_10
|Compound-05271 1H d20_10

Hit3 - Record ID 3 ‘

Database
loclhost - Adds 1000
llocalhost - Adds 1000
llocalhost - Adds 3

Pages g x
- [a]
d 1 —
Hits table
| 2. Aspirin_A2_neu_NOESY_01
Hits table
3. (1) Aspirin_plus_C_Test_NOES'
Query + Hit 1
hd
=
v =

... Query + Hit 2... Etc.

Below is an example of an Mnova or PDF report using a custom template with the Hit table and Stack options

enabled.

| Structure | Structure Label J TYPE ‘ Solvent | Database J Score
Hit1-Record ID 1 . Compound-44289 |1H d20_10 localhost - Adds 1000
]
s
Hit2 - Record ID 4 ‘Compound—24315 1H d20_10 |loclhost - Adds |1000
Hit3 - Record ID 3 Compound-05271 |1H d20_10 |loclhost - Adds |733

L]

P/N 238 R1.1
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Parameter Vale
Data Fie Name X/ 2014/
20140630/
I T
mE . T
el fi
d/ fid
Experment 1D

Number of Scans 128
Recever Gan 0
Rebxation Delay 3.5000

Pulse Width 0.0000

Acquistion Time 2.5000

Spectrometer 599.93

Frequency

Spectral Width ~ 9615.4

Lowest -1115.4
Frequency

Nuckus 1H

Acqured Size 24038
Spectral Sge 65536
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2.4. Other output

- A “documents” directory, containing the output Mnova files (unless Mgears is configured to save Mnova
files in another location).

- A “pdf” directory, containing the output PDF files (unless Mgears is configured to save PDF files in another
location).

- Alog file of the execution.

- A copy of the settings used in the current evaluation.

- A resume file of the steps followed in the execution.

- ACSS folder, a data folder, an JS folder, and an images folder.

3. Mnova Gears Results Viewer

DB Search is compatible with the Mnova Gears Results Viewer. Open the Mgears Viewer from the Mnova
Automation tab.

MestReNova

Elucidation Chemometrics Binding Automation

Mgears [Mgears | MyGears MyGears

Workflows

Click on ™ and select the DB Search output folder to open. The experiment results will be loaded into the
Mgears Viewer dialog.

Mgears Viewer - 2022-11-21T715.46.08_StartingGuide-1 g X
[
WEF HEO &« EEE )
# Title Document Location
1 SAMPLE 1 SAMPLE 1.mnova C:/Users/Usuario/Desktop/Results/DB Search/2022-11-21T15.46.0
2 SAMPLE 2 SAMPLE 2.mnova C:/Users/Usuario/Desktop/Results/DB Search/2022-11-21T15.46.0
3 SAMPLE 3 SAMPLE 3.mnova C:/Users/Usuario/Desktop/Results/DB Search/2022-11-21T15.46.0
4 SAMPLE 4 SAMPLE 4.mnova C:/Users/Usuario/Desktop/Results/DB Search/2022-11-21T15.46.0
5 SAMPLE 5 SAMPLE 5.mnova C:/Users/Usuario/Desktop/Results/DB Search/2022-11-21T15.46.0
4 »
Well Plate

Results

DB Search

1H Hits:3
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Select a sample in the table or well plate to view the detailed results. The Mgears Viewer dialog will display
the Number of hits in the Results section, and the Mnova results file will be opened to show the hit and query
spectra details.

Mgears Viewer - 2022-11-21T715.46.08_StartingGuide-1 g x ﬂ] SAMPLE 4* x
_ - %
] 5 r I.—l @ (| ¢ L 2] @ EI Analyze = Strudture Label | TYPE | Solvent | Database | Score
Again Hit1 - Reaord 1D 1 Compound-44289 | 1H d20_10 [localhest- Adds | 1000
- i
| # Title Document -
Hit 2 - Reaord ID 4 Compound-24315 |1H 2010 localhost- Adds | 1000
1 SAMPLE 1 SAMPLE 1.mnova C:/Users/Usuario/Desktop/Results/DB Search, |
Hit 3 - Record ID 8 Compound-33456 |14 |d20_10 localhost- Adds (356 Mestrelab Research
2 SAMPLE 2 SAMPLE 2.mnova C:/Users/Usuario/Desktop/Results/DB Search,
3 SAMPLE 3 SAMPLE 3.mnova C:/Users/Usuario/Desktop/Results/DB Search Hit4 - Record 10 3 e [Pomeond0R271 IH (2010 lloclhost- Adds 933
l4 SAMPLE 4 SAMPLE 4.mnova C:/Users/Usuario/Desktop/Results/DB Search, |- it - Reaxd 1D 2 : Compound-67200 | 1K 42010 lloclhost - Adds 913
5 SAMPLE 5 SAMPLE 5.mnova C:/Wsers/Usuario/Desktop/Results/DB Search, \ |Hit6 -Recrd 1D 5 Compound-26549 | 1H DMSO  |localhost - Adds | 733
| «] »
Well Plate 0
/ - il - ]
1 2 3 4 5 6 7 8 9 10 11 [&iEE] “ F L
Al3 1 2 o 0 IIllA Lplly] .”.
K| v ST TV N T -

Results / - —4HJ -

DB Search — ” Lk - ;
/ [l [

For more details on Minova Gears’ options, please refer to the Minova Gears manual.
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